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1   Introduction 
 
The Roadway Construction Noise Model (RCNM) is the Federal Highway 
Administration’s (FHWA) national model for the prediction of construction noise.  Due 
to the fact that construction is often conducted in close proximity to residences and 
businesses, construction noise must be controlled and monitored to avoid impacts on 
surrounding communities.  In addition to community issues, excessive noise can threaten 
a construction project’s progress.  Each project needs to balance the community’s need 
for peace and quiet with the contractor’s need to progress the work. 
 
The Central Artery/Tunnel (CA/T) project in Boston, Massachusetts, which began in the 
early 1990s, is the largest urban construction project ever conducted in the United States.  
Its noise control program developed the Construction Noise Control Specification 
721.560, the most comprehensive noise specification ever developed in the United States 
[1].  As part of the CA/T project noise control program, a construction noise prediction 
spreadsheet was developed [2].  Because the CA/T prediction tool can benefit other state 
and local governments, the FHWA developed the RCNM, which is based on the noise 
prediction calculations and the equipment database used in the CA/T prediction 
spreadsheet.  The RCNM provides a construction noise screening tool to easily predict 
construction noise levels and to determine compliance with noise limits for a variety of 
construction noise projects of varying complexity. 
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2   Background 
 
The RCNM is a national model based on the noise calculations and extensive 
construction noise data compiled for the CA/T Project.  The basis for the national model 
is a spreadsheet tool developed in support of the CA/T project [2].  The CA/T predictions 
originated from Environmental Protection Agency (EPA) noise level work [3] and an 
Empire State Electric Energy Research Corp. Guide [4] which utilizes an “acoustical 
usage factor” to estimate the fraction of time each piece of construction equipment is 
operating at full power (i.e., its loudest condition) during a construction operation.  Table 
1 presents a construction equipment noise database compiled through the CA/T project 
[2].  This database is used to predict construction noise within the RCNM.  The noise 
levels listed represent the A-weighted maximum sound level (Lmax), measured at a 
distance of 50 feet from the construction equipment. 
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Table 1.  CA/T equipment noise emissions and acoustical usage factors database. 
CA/T Noise Emission Reference Levels and Usage Factors 
filename:  EQUIPLST.xls 
revised: 7/26/05 Acoustical Spec 721.560 Actual Measured No. of Actual

Impact Use Factor Lmax @ 50ft Lmax @ 50ft Data Samples
Equipment Description Device ? ( % ) (dBA, slow) (dBA, slow) (Count)

(samples averaged) 
  All Other Equipment > 5 HP No 50 85 -- N/A -- 0 
  Auger Drill Rig No 20 85 84 36 
  Backhoe No 40 80 78 372 
  Bar Bender No 20 80 -- N/A -- 0 
  Blasting Yes -- N/A -- 94 -- N/A -- 0 
  Boring Jack Power Unit  No 50 80 83 1 
  Chain Saw No 20 85 84 46 
  Clam Shovel (dropping) Yes 20 93 87 4 
  Compactor (ground) No 20 80 83 57 
  Compressor (air) No 40 80 78 18 
  Concrete Batch Plant No 15 83 -- N/A -- 0 
  Concrete Mixer Truck No 40 85 79 40 
  Concrete Pump Truck No 20 82 81 30 
  Concrete Saw No 20 90 90 55 
  Crane No 16 85 81 405 
  Dozer No 40 85 82 55 
  Drill Rig Truck No 20 84 79 22 
  Drum Mixer No 50 80 80 1 
  Dump Truck No 40 84 76 31 
  Excavator No 40 85 81 170 
  Flat Bed Truck No 40 84 74 4 
  Front End Loader No 40 80 79 96 
  Generator No 50 82 81 19 
  Generator (<25KVA, VMS signs) No 50 70 73 74 
  Gradall No 40 85 83 70 
  Grader No 40 85 -- N/A -- 0 
  Grapple (on backhoe) No 40 85 87 1 
  Horizontal Boring Hydr. Jack No 25 80 82 6 
  Hydra Break Ram Yes 10 90 -- N/A -- 0 
  Impact Pile Driver Yes 20 95 101 11 
  Jackhammer Yes 20 85 89 133 
  Man Lift No 20 85 75 23 
  Mounted Impact Hammer (hoe ram) Yes 20 90 90 212 
  Pavement Scarafier No 20 85 90 2 
  Paver No 50 85 77 9 
  Pickup Truck No 40 55 75 1 
  Pneumatic Tools No 50 85 85 90 
  Pumps No 50 77 81 17 
  Refrigerator Unit No 100 82 73 3 
  Rivit Buster/chipping gun Yes 20 85 79 19 
  Rock Drill No 20 85 81 3 
  Roller No 20 85 80 16 
  Sand Blasting  No 20 85 96 9 
  Scraper No 40 85 84 12 
  Shears (on backhoe) No 40 85 96 5 
  Slurry Plant No 100 78 78 1 
  Slurry Trenching Machine No 50 82 80 75 
  Soil Mix Drill Rig No 50 80 -- N/A -- 0 
  Tractor No 40 84 -- N/A -- 0 
  Vacuum Excavator (Vac-truck) No 40 85 85 149 
  Vacuum Street Sweeper No 10 80 82 19 
  Ventilation Fan No 100 85 79 13 
  Vibrating Hopper No 50 85 87 1 
  Vibratory Concrete Mixer No 20 80 80 1 
  Vibratory Pile Driver No 20 95 101 44 
  Warning Horn No 5 85 83 12 
  Welder / Torch No 40 73 74 5 

(Single Nozzle) 

 

cbarnobi
Sticky Note
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3  The RCNM 
 
The RCNM is a computer program used to assess construction noise impacts.  The 
computer on which it is installed should be equipped with the Microsoft Windows 98 or 
newer operating system (OS) and 192 MB or more of random access memory (RAM).  
The display should be set to 1024 x 768 pixels or greater, and the computer should carry 
the Adobe Acrobat 4.0 or newer software.  
 
The RCNM allows the estimation of three key metrics of interest:  Lmax, Leq, and L10 at 
receptor locations for a construction operation that can include up to 20 pieces of 
equipment.  RCNM allows for user-defined construction equipment and user-defined 
noise limit criteria.  The two main uses of the RCNM are to allow typical computer users 
to: 1. easily predict noise emissions from construction equipment, and 2. determine a 
construction work plan’s compliance with noise criteria limits.  A variety of construction 
work scenarios can be created quickly, allowing the user to determine the impact of 
changing construction equipment and adding/removing the effects of shielding due to 
noise mitigation devices such as barriers.   

3.1   RCNM Main Page 
 
The RCNM consists of one main display page with Input Data and Results sections, 
shown in Figure 1.   
 

 
 

Figure 1.  The RCNM main page 
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Several command buttons and pull-down menus allow the user to modify the input data 
before results are calculated by the model. 
 
3.1.1  File Menu 
 
The <File> menu, shown in Figure 2, contains items that allow the user to create, open, 
and save a case, export the results of a case, and exit the program. 

 

 

Figure 2. <File> Menu 
 
• <New> creates a new case.  If a case is currently open, the user is prompted to save it 

before closing. 
• <Open…> allows the user to open an existing case file ([name].cas). 
• <Save> saves the case with the current filename.  If this is a new case, the user is 

asked for a new filename ([name].cas). 
• <Save As…> The user is asked for a filename for a new case ([name].cas) and saves 

the case with that filename. 
• <Export Results> prompts the user to save the case results for the current or all 

receptors to a comma separated value (CSV) file with the following naming 
convention:  [name].csv.  This type of file is easily read into a spreadsheet program. 
The user can also save the case results to a text file (TXT), which saves the results to 
a space-separated text format with the following naming convention: [name].txt. 

• <Exit> closes the application.  If changes have been made to the open case, the user is 
asked if he/she would like to save the case. 

 
3.1.2 Edit Menu 
 
The <Edit> menu, shown in Figure 3, allows the user to copy and paste data, delete data, 
and undo changes.  

 
 

Figure 3. <Edit> Menu 
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• <Copy> lets the user copy into a clipboard the contents of a single cell or an entire 

line from an RCNM dialogue box. 
• <Paste> lets the user copy the contents of the clipboard into a single cell or an entire 

line of an RCNM dialogue box. 
• <Delete> lets the user delete from the case a receptor or piece of equipment selected 

in the receptor or equipment dialogue box. 
• <Undo> lets the user revert the RCNM one step to where it was before the latest 

change was made. 
 
3.1.3   View Menu 
 
The <View> menu, shown in Figure 4, allows the user to focus in <Zoom +> on either 
the Input Data or Results section of the RCNM’s main page.  To activate Zoom +, click 
on Zoom + and guide the spyglass + icon to either Input Data or Results and single-click. 
 

 
 

Figure 4.  <View> Menu 
 

To deactivate Zoom + and go back to the full RCNM screen, click on Zoom – and guide 
the spyglass – icon to the Input Data or Results section that has been maximized on the 
screen. 
 
3.1.4   Options Menu 
 
The <Options> menu, shown in Figure 5, allows the user to modify the equipment list 
and change the case’s units of measure from feet to meters. 
 

 
 

Figure 5.  <Options> menu 
 

The <Options> menu allows the user to add new types of equipment to the equipment 
list.  The equipment list modification dialogue box, shown in Figure 6, allows the user to 
specify a user-defined piece of equipment and add it.  The user can specify the following 
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data:  whether the equipment is an impact device, the equipment’s usage factor1, and the 
equipment’s Lmax level (spec and/or actual2).  The user can also delete equipment that’s 
been added by selecting it and clicking the delete button.  The default equipment cannot 
be modified, but it may be deleted entirely from the case by selecting it and clicking the 
delete button.  Selecting the default button restores the default equipment list (from the 
CA/T Project) and eliminates any user-defined equipment. 
 

 
 

Figure 6.  Equipment list modification dialogue box 
 
Data for user-defined pieces of equipment may be saved to an equipment file 
([name].equ), along with all other equipment in the current list, including default 
equipment.  This file may be opened in other cases to incorporate these pieces of 
equipment. 
 
The <Options> menu, as shown in Figure 7, also allows the user to change the case’s 
units of measure from feet to meters or from meters to feet.  The only input data affected 
by this tool are the Distance to Receptor values.  
 

                                                 
1 Usage factor is the percentage of time during a construction noise operation that a piece of construction 
equipment is operating at full power.  In the case of construction blasting, the equipment gives a very short 
duration blast, and can be quantified by using a 1% usage factor in the RCNM to allow for some prediction.  
Never use a usage factor of zero because the log of zero causes a mathematical impossibility.  The usage 
factor term only affects the computation of Leq and L10.  The usage factor does not enter into the equation 
when calculating the more important term for blasting, that being the Lmax.   
2 “Spec” refers to noise levels stated in noise specifications, and “Actual” refers to Lmax values measured 
at 50 ft from the equipment. 
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Figure 7.  Units modification pull-down menu 
 

3.1.5   Help Menu 
 
The <Help> Menu loads for the user the RCNM User’s Guide in Portable Document 
Format (PDF).  This PDF is searchable by key word using the Adobe Acrobat Edit / Find 
search tool. 

3.2  Input Data 
 
The user is required to input receptor data and equipment data before a case can be 
processed.  The user is advised to type in some summary comments about the case in the 
Case Description dialogue box before inputting data.  Also, in order to determine noise 
limit exceedance values, the user can input noise limit criteria. 
 
3.2.1  Receptors 
 
Multiple receptors may be input for a case, but only one receptor may be processed at a 
time.  The name of the highlighted receptor chosen for processing appears in blue type 
above the Equipment input dialogue box and the Noise Limits command button (see 
Figure 1).  The user specifies the receptors for a study by entering information into the 
Receptors input box in the main window of the RCNM.  The user is required to enter the 
receptor name, land use, daytime baseline L10 or Leq, evening baseline L10 or Leq, and 
nighttime baseline L10 or Leq.  The baseline levels indicate the sound level at a receptor 
before any construction noise contributions.  Baseline levels are only necessary if the 
desired noise criteria limits are based on relative increases in noise level.  If the desired 
noise criteria limits are absolute noise levels, then the user should insert a placeholder 
number other than zero.   
 
When entering information for more than one receptor, it may be desirable to copy 
information already entered.  An entire receptor row may be highlighted and copied to 
another row, where copying multiple rows requires the selection of the same number of 
rows when pasting (this same functionality also applies to editable cells).  Note: Entire 
rows may be selected by clicking on the row number. 
 
Again, the RCNM will only calculate results for the receptor displayed in blue type in the 
Input Data portion of the main page.  The results for other receptors may be displayed by 
selecting the desired receptor in the Receptor window; to select a receptor, click in any 
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cell in the row.  Up to 100 receptors may be included in any case.  Information for 
receptors is saved in the case file ([name].cas). 
 
 
3.2.2 Equipment 
 
Core equipment noise data are stored in the RCNM and are accessible by a pull-down 
menu in the main page, as in Figure 8. 
 

 
 

Figure 8.  Equipment dialogue box, with pull-down menu shown 
 

As discussed in Section 3.1.4, new pieces of equipment may be added to a case and saved 
in an equipment file ([name].equ).  When the user-defined equipment file is opened 
through the <Options> / <Modify the Equipment List> menu, user-defined equipment 
will appear in the equipment pull-down menu.  The user activates and inactivates chosen 
equipment types by ticking and unticking the “Active” checkbox.  The user is required to 
specify:  

 
1. The type of reference emission levels to use (“Spec”, if applicable, or “Actual”, 

[the default is “Actual”]);  
2. Distance to Receptor – that is, the distance between each type of equipment and 

the receptor being analyzed (the default distance is 50 feet); and 
3. Estimated Shielding (in dBA) associated with each type of equipment (can leave 

the default value of 0.0 when not considering shielding).  NOTE:  A Best 
Practices document is presented in Appendix A showing how to determine 
Estimated Shielding using several Rules of Thumb developed from 
experience at the CA/T project. 

 
When entering information for more than one piece of equipment, it may be desirable to 
copy information already entered.  An entire equipment row may be highlighted and 
copied to another row, where copying multiple rows requires the selection of the same 
number of rows when pasting (this same functionality also applies to editable cells).  
Note:  Entire rows may be selected by clicking on the row number. 
 
The user may analyze up to 20 pieces of equipment at one time, and they may be 
included in any combination of different or identical equipment types. 
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3.2.3  Noise Metric and Noise Limit Criteria 
 
While a case is open, the user can choose a noise metric (for baseline levels, noise limits, 
and calculated results) and enter the noise limit criteria for a local area.  The user may 
edit the Lmax and L10 or Leq day, evening, and night noise limit criteria for a residential, 
commercial, or industrial area.  Daytime, evening, and nighttime may represent any time 
periods the user wishes, but they are typically defined as 7 AM to 6 PM, 6 PM to 10 PM, 
and 10 PM to 7 AM, respectively.  The criteria, used together with the baseline sound 
levels, define the noise limits for each receptor.  CA/T Noise Limit Criteria are used as a 
default [1], but users may input their own criteria.  The RCNM offers a metric pull-down 
menu and two or three command buttons to the right of the Receptor input dialogue box.   
 
• Metric Pull-Down Menu 
 
A pull-down menu allows the user to choose between the L10 or Leq metric, as in Figure 
9.  The chosen metric represents that used for the baseline levels, noise limits, and 
calculated results.  For the noise limits and calculated results, Lmax values are also 
included. 
 

 
 

Figure 9.  Noise Metric pull-down menu 
 

• Noise Limit Criteria Pop-up Dialogue Box 
 
A pop-up dialogue box allows the user to specify Noise Limit Criteria information for an 
area being studied in a case, as in Figure 10.  The flexibility of the Noise Limit Criteria 
allows RCNM users to incorporate criteria based on local noise ordinances and baseline 
levels measured for each receptor. 
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Figure 10.  Noise Limit Criteria pop-up dialogue box 
 
The user may populate this dialogue box with Noise Limit Criteria information derived 
from CA/T Construction Noise Control Spec. 721.560 [1] by clicking on the “Default” 
command button and clicking “Yes” when asked to load information from the default 
file, which is stored in the RCNM (see Table 2).   

Table 2. Default Noise Limit Criteria 
 Daytime (7 AM to 6 PM) Evening (6 PM to 10 PM) Nighttime (10 PM to 7 AM) 

Land Use L10 Limit 
(dBA) 

Lmax Limit 
(dBA) 

L10 Limit 
(dBA) 

Lmax Limit 
(dBA) 

L10 Limit 
(dBA) 

Lmax Limit 
(dBA) 

Residential 

maximum of 75 
and baseline + 

5 for non-
impact* and 
exempt for 
impact** 

85 for non-
impact and 90 for 

impact 
baseline + 5 85 

if baseline <70 
then baseline 

+5;  if baseline 
≥70 then 

baseline + 3 

80 

Commercial 

maximum of 80 
and baseline + 

5 for non-
impact and 
exempt for 

impact 

N/A N/A N/A N/A N/A 

Industrial 

maximum of 85 
and baseline+5 
for non-impact 
and exempt for 

impact 

N/A N/A N/A N/A N/A 

*     Non-impact equipment is equipment that generates a constant noise level while in operation. 
**   Impact Equipment is equipment that generates impulsive noise.  Impulse Noise is defined as noise produced by 
the periodic impact of a mass on a surface, of short duration (generally less than one second), high intensity, abrupt 
onset and rapid decay, and often rapidly changing spectral composition. 
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Otherwise, the user may clear any information present in the dialogue box and specify 
new data in each cell.  Clicking on the “Clear” command button will prompt the user to 
set all the cells in the dialogue box to Not Applicable (N/A), as in Figure 11.  By clicking 
“Yes,” the user will populate all cells with N/A; by clicking “No,” the dialogue box will 
return to the data present before the user clicked “Clear.” 
 

 

 
 

Figure 11.  The Noise Limit Criteria “Clear” command button 
 
Clicking on any cell in the Noise Limit Criteria dialogue box reveals a Noise Limit 
Criteria pull-down menu.  Click on this pull-down menu to access the six options, as in 
Figure 12. 
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Figure 12.  Noise Limit Criteria pull-down menu 
 
Through these six options, the user specifies what Noise Limit Criteria changes, if any, 
are desirable in each cell.  The six cell options are: 
 

i. Exempt (for the specified metric and land use, the equipment is exempt from 
noise limits) 

ii. N/A (for the specified metric and land use, the equipment does not have 
applicable noise limits) 

iii. Value (user is prompted to enter a value for which the noise level should not 
exceed), as in Figure 13: 

 

 
 

Figure 13.  Noise Limit Criteria “Value” dialogue box 
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iv. Maximum (set value for which a noise level should not exceed to the 

maximum of two possible levels:  A user-defined level or the Baseline level 
plus some user-defined increment), as in Figure 14:  

 

 
 

Figure 14.  Noise Limit Criteria “Maximum” dialogue box 
 

v. Baseline + (set value for which a noise level should not exceed to the 
Baseline level plus some user-defined increment), as in Figure 15: 

 

 
 

Figure 15.  Noise Limit Criteria “Baseline +” dialogue box 
 

vi. Conditional (set conditional value for which a noise level should not exceed; 
the user is prompted to enter the following information: 1. a comparison 
value, i.e., “If Baseline < [value], then …”; 2. an increment value to add to 
the baseline level if the baseline level is less than the comparison value; 3. 
an increment value to add to the baseline level if the baseline level is greater 
than or equal to the comparison value), as in Figure 16: 



RCNM User’s Guide  The RCNM 

15 

 

 
 

Figure 16.  Noise Limit Criteria “Conditional” dialogue box 
 
To see the current value of a cell, simply hold the mouse pointer over the cell.  Once the 
user has specified values for all the cells in the Noise Limit Criteria dialogue box, these 
criteria can be saved in a criteria file ([name].cri) by clicking on the “Save” command 
button.  The user will be prompted to give the criteria file a name.  These criteria can 
thereafter be loaded into any case by clicking on the “Open” command button.    
 
The user returns to the Noise Limit Criteria dialogue box by clicking “Ok”, and returns to 
the case by clicking “Ok” again. 
 
• L10 Calculation (this button is present if the L10 metric is chosen) 
 
By clicking on the  “L10 Calculation” command button, the user can specify the 
adjustment factor used to calculate L10, as in Figure 17.  By clicking the “Default” 
command button, the user automatically calls for an adjustment factor of 3 dBA, a value 
empirically derived from extensive CA/T Project data [2]. 
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Figure 17.  L10 Adjustment dialogue box 
 
• Noise Limits 
 
The “Noise Limits” command button opens a display window that looks exactly like the 
“Noise Limit Criteria” dialogue box, except that it is not editable, and the only button in 
the opened window is “Ok”.  The values in the cells are based on the criteria set in the 
Noise Limit Criteria window and the baseline levels for the selected receiver, as in Figure 
18.  (If a receiver is not selected, the dialogue box is unavailable for viewing.) 
 

 
 

Figure 18.  Noise Limits display window 
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Again, these limits may be changed by the user through the Noise Limit Criteria data 
entry window. 
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4   Results 
 
Once the data for one receptor and up to 20 pieces of equipment have been specified in 
the Input Data portion of the main screen, the RCNM will automatically calculate the 
Results readout displayed in the bottom portion of the main screen, as in Figure 19.  Any 
changes to the Input Data will automatically cause the RCNM to update the Results.  The 
results for only one receptor will be displayed at a time; results for other receptors can be 
displayed by selecting the desired receptor in the Receptor window (click in any cell in 
the desired receptor row).  Results for up to 100 receptors can be saved in a case.  If 
Noise Limit Criteria information has been specified, the corresponding results (limits and 
exceedance values) will be updated as well.    
 

 
 

Figure 19.  The RCNM main-page Results display 
 
If there is insufficient input data for RCNM to compute a result, then a “Check Input 
Data” button will appear in the middle of the screen.  Clicking on this button will provide 
the user with an indication of what additional input data are required. 
 
The Results are presented in a read-only spreadsheet that contains the following fields, all 
applicable to the selected receptor: 
 
• Equipment – the name/description of the equipment type  
• Calculated Lmax – the calculated Lmax value for the equipment type.  This is 

calculated from the “Spec” or “Actual” equipment Lmax, distance, and estimated 
shielding. 
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• Calculated Leq or L10 – the calculated Leq or L10 value (depending on what is 
selected in the Noise Metric pull-down menu) for the equipment type.  This is 
calculated from the Calculated Lmax values, equipment usage factors, and selected 
adjustment factor.   

• Day Lmax Noise Limit – the daytime Lmax noise limit for the equipment type.  
• Day Leq or L10 Noise Limit – the daytime Leq or L10 noise limit for the equipment 

type.  
• Evening Lmax Noise Limit – the evening Lmax noise limit for the equipment type.  
• Evening Leq or L10 Noise Limit – the evening Leq or L10 noise limit for the 

equipment type.  
• Night Lmax Noise Limit – the nighttime Lmax noise limit for the equipment type.  
• Night Leq or L10 Noise Limit – the nighttime Leq or L10 noise limit for the 

equipment type.  
• Day Lmax Noise Limit Exceedance – the daytime Lmax noise limit exceedance for 

the equipment type.  If the criteria limit was not exceeded, the value is “None”.   
• Day Leq or L10 Noise Limit Exceedance – the daytime Leq or L10 noise limit 

exceedance for the equipment type.  If the criteria limit was not exceeded, the value is 
“None”.  

• Evening Lmax Noise Limit Exceedance – the evening Lmax noise limit exceedance 
for the equipment type.  If the criteria limit was not exceeded, the value is “None”.   

• Evening Leq or L10 Noise Limit Exceedance – the evening Leq or L10 noise limit 
exceedance for the equipment type.  If the criteria limit was not exceeded, the value is 
“None”.   

• Night Lmax Noise Limit Exceedance – the nighttime Lmax noise limit exceedance 
for the equipment type.  If the criteria limit was not exceeded, the value is “None”.   

• Night Leq or L10 Noise Limit Exceedance – the nighttime Leq or L10 noise limit 
exceedance for the equipment type.  If the criteria limit was not exceeded, the value is 
“None”.   

 
The user may scroll down to view equipment results that are not visible, or the <View> / 
<Zoom +> menu may be used to zoom in on the Results display only (see Section 3.1.3).  
There is a row at the top of the Results display, highlighted in yellow, that calculates the 
total for all equipment combined.  This row is always visible during scrolling of the 
Results spreadsheet.  (Calculations for totals are explained in Section 5.3.) 
 
Again, users may export a case’s input information and results to a comma separated 
value (CSV) report file ([name].csv) by choosing the <Export Results> option from the 
<File> menu.  The user can also save the case results to a text file (TXT), which saves the 
results to a space-separated text format ([name].txt).  Results may be saved for a single 
receptor or all receptors in the case. 
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5   Calculations in the RCNM 
 
The RCNM uses the primary equation described in the CA/T Construction Noise Control 
Specification 721.560 [1] for the construction noise calculations. 
 

5.1   Metric Calculation 
 
LmaxCalc = selected_Lmax – 20log(D/50) - shielding                                             (1) 
 
where   
 

selected_Lmax is the “Spec” or “Actual” maximum A-weighted sound level at 50 
ft., listed in Table 1 for all pieces of equipment, in dBA, 
D is the distance between the equipment and the receptor, in feet,  
shielding is the insertion loss of any barriers or mitigation, in dBA (see Appendix 
A). 

 
Leq = LmaxCalc + 10log(U.F.%/100)                                                                       (2) 
 
where   
 

U.F.% is the time-averaging equipment usage factor, in percent (see footnote 1 on 
p 7). 
 

L10 = Leq + 3 dBA adjustment factor                                                                        (3) 
 
The RCNM calculates L10 by adding 3 dBA to the Leq, where the 3 dBA default L10 
adjustment factor was empirically derived by comparing extensive CA/T construction 
noise data.  This adjustment factor may be changed in the RCNM at the user’s discretion. 

5.2  Exceedance Calculation 
 
Daytime Lmax Exceedance = LmaxCalc – Daytime Lmax Limit                                (4) 
 
Daytime Leq or L10 Exceedance = Leq or L10 – Daytime Leq or L10 Limit             (5) 
 
Evening Lmax Exceedance = LmaxCalc – Evening Lmax Limit                                 (6) 
 
Evening Leq or L10 Exceedance = Leq or L10 – Evening Leq or L10 Limit               (7) 
 
Nighttime Lmax Exceedance = LmaxCalc – Nighttime Lmax Limit                           (8) 
 
Nighttime Leq or L10 Exceedance  = Leq or L10 – Nighttime Leq or L10 Limit        (9) 
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5.3 Totals Calculation 
 
The Total values in the Results section are determined in the following manner:  
 

1) Total Leq = 10*log(Σ (individual equipment Leq values3)) 
2) Total L10 = 10*log(Σ (individual equipment L10 values3)) 
3) Total Lmax = Maximum among individual equipment Lmax values 
4) Total noise limits and limit exceedances: 

a. Determine whether or not total is impact or non-impact 
i. If all the equipment is non-impact, label the total as non-impact. 

ii. If all the equipment is impact, label the total as impact. 
iii. If the equipment is mixed non-impact and impact, label the total as 

non-impact. 
b. Determine total noise limits and limit exceedances the same way as with 
individual pieces of equipment (see Section 5.2), only use the calculated total 
sound levels (Total Leq or Total L10) and the impact or non-impact label 
according to the criteria specified in i through iii. 

 

 

                                                 
3 The Leq and L10 levels are energy averages. 
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Appendix A:  Best Practices for Calculating Estimated Shielding for Use in the 
RCNM 

 
This Appendix presents some simplified shielding factors for use in the RCNM.  These 
suggestions are "rules of thumb" based on experience gathered by CA/T construction 
noise experts working in the field [2].   
 
1)  If a noise barrier or other obstruction (like a dirt mound) just barely breaks the line-of-
sight between the noise source and the receptor, use 3 dBA. 
 
2)  If the noise source is completely enclosed OR completely shielded with a solid barrier 
located close to the source, use 8 dBA.  If the enclosure and/or barrier has some gaps in 
it, reduce the effectiveness to 5 dBA. 
 
3)  If the noise source is completely enclosed AND completely shielded with a solid 
barrier located close to the source, use 10 dBA. 
 
4)  If a building stands between the noise source and receptor and completely shields the 
noise source, use 15 dBA. 
 
5)  If a noise source is enclosed or shielded with heavy vinyl noise curtain material (e.g., 
SoundSeal BBC-13-2" or equivalent), use 5 dBA. 
 
6)  If dilapidated windows are replaced with new acoustical windows, or quality internal 
or exterior storm sashes, use an incremental improvement of 10 dBA for an overall 
Outside-to-Inside Noise Reduction (OINR) of 35 dBA.   
 
7)  If work is occurring deep inside a tunnel using the "top-down" construction method 
(i.e. cover the tunnel work with concrete roadway decks to allow surface traffic and then 
excavate underneath the roof deck), use 12 dBA.   
 
 
 
 


